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Description

Standalone ±30A Power/
Energy Monitor with LCD

The DC2574A-KIT is a standalone power/energy monitor 
that allows users to evaluate the LTC®2947 power/energy 
monitor without a PC. This document describes how to 
quickly set up and operate the DC2574A-KIT; users should 
also refer to the DC2334 demo manual and LTC2947 data 
sheet for more details. The DC2574A-KIT includes all 
components required for stand-alone operation except 
for a power supply and load. The DC2574A-KIT operates 
with any USB compatible power supply and any load 
compatible with the LTC2947.

The DC2574A-KIT includes the following items:
nn DC2334A: LTC2947 Demo Circuit
nn DC2026: Linduino® One with Pre-Programmed 

“LTC2947 - DC2574A_KIT Linduino.INO File”

Make sure the DC2334A demo board is configured for I2C 
mode (JP5, JP6) with AD0, AD1 both being set to the L 
position (JP8, JP7) which sets the slave address to 0x5C. 
This is the factory default setting of the jumpers on the 
DC2334 demo board.

L, LT, LTC, LTM, Linear Technology, Linduino, QuikEval and the Linear logo are registered 
trademarks of Linear Technology Corporation. All other trademarks are the property of their 
respective owners.

Connections

nn LCD Keypad Shield
nn USB Cable: Power Supply And Optional Communica-

tion Interface for Operating with the GUI
nn 14-pin Ribbon Cable. Only necessary for usage of 

the Linduino with some other LTC demo boards, see 
Linduino DC590 Mode section on how to reprogram 
the supplied Linduino for full compatibility with 
QuikEval®.

The KIT is provided fully assembled and all boards plugged 
together (LCD on top of DC2334A on top of DC2026) for 
easy usage without soldering anything.

Design files for this circuit board are available at  
http://www.linear.com/demo/DC2574A-KIT

Connect an external supply (0V to 15V) and load (±30A) 
to be monitored by the LTC2947 and plug in a USB power 
supply to the USB port of the Linduino. See the DC2334 
demo manual for more information on possible measure-
ment configurations.

Figure 1. DC2574A-KIT Connection Diagram
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Operation

Connections

Upon power up, the LCD shows four numerical values. 
They correspond to the current, voltage, die temperature 
and power measurements, in clockwise order.

Description Example

Current Voltage 0.003A 0.000V

Power Die Temperature 0.000W 25.0 °C

The keys of the LCD keypad shield are used to select what 
values are displayed.

Key Description

LEFT, RIGHT Press and hold to navigate through and select 
measurement group to be displayed

UP, DOWN Press and hold to navigate through and select status/
alerts registers to be displayed.

SELECT Clear accumulators and tracking registers. Press and hold 
this key until the display shows the message CLEAR. After 
releasing the key again the clearing will be acknowledged 
by the message ****CLEARED*****

RST Reset the controller (the Linduino) and start over. This will 
not reset the LTC2947

Measurement Groups (LEFT, RIGHT Keys)

Press and hold the LEFT or RIGHT key to cycle through 
and select the measurement group to be displayed. As the 
RIGHT key is held down, the display will cycle through the 
following measurement groups (the same applies to the 
LEFT key but it will cycle through measurement groups 
in the opposite order):

I V Current (I), Voltage (V), 

P TEMP Power (P) and Temperature (TEMP) Measurement

↓

C1 VDVCC Charge1 (C1), LTC2947 Supply Voltage (VDVCC), 

E1 TB1 Energy1 (E1), Time Base 1 (TB1)

↓

C2 VDVCC Charge2 (C2), LTC2947 Supply Voltage (VDVCC), 

E2 TB2 Energy2 (E2), Time Base 2 (TB2)

↓

IMIN IMAX Minimum/Maximum Current (IMIN, IMAX),

PMIN PMAX Minimum/Maximum Power (PMIN, PMAX)

↓

VMIN VMAX Minimum/Maximum Voltage (VMIN, VMAX), 

TMIN TMAX Minimum/Maximum Temperature (TMIN, TMAX)

↓

TMIN TMAX Minimum/Maximum Temperature (TMIN, TMAX),

VDMIN VDMAX Minimum/Maximum LTC2947 Supply Voltage 
(VDMIN, VDMAX)

↓

CYCLE ALL If “CYCLE ALL measurements” is selected, the display 
will cycle through all available measurement groups.measurements

Note: If you use the USB port of a PC as a power supply, 
the board will make periodic resets. This is caused by 
Windows and the USB COM port driver accessing the 
COM port assigned to the Linduino. This can be prevented 
by making a connection via a serial terminal (see Serial 

Terminal Operation) or via the LTC2947 GUI (see QuikEval/
GUI Operation) to the COM port of the Linduino. If a plain 
external USB power supply is used, this problem does 
not appear.



3
dc2574akitf

DEMO MANUAL  
DC2574A-KIT

Operation
Once the key is released the measurements of the selected 
group will be displayed.

Measurement Report

The measurement results will be reported in the follow-
ing units:

Measurement Unit Description Example

Current A Amperes 1.003A

Voltage V Volts 5.200V

Power W Watts –99.050W

Charge mAh, kAh, Ah (milli, kilo) ampere hours 999mAh

Energy mWh, kWh, Wh (milli, kilo) watt hours 120Wh

Time s, m, h, d Seconds, minutes, hours, 
days

1d3h

The tracking-registers that store the minimum and maxi-
mum values of measurements are reported in the following 
way: VALMIN...VALMAX, e.g. –10.03A...12.00A.

Status/Alert Registers (UP, DOWN Keys)

Press and hold the UP or DOWN key to cycle through 
and select a status/alert registers to be displayed. As the 
DOWN key is held down, the display will cycle through 
the following status/alert registers (the same applies to 
the UP key but it will cycle through status/alert registers 
in the opposite order):

STATUS,ALERTS:
STATUS

↓

→ See the table on the following  
page for descriptions.

STATUS,ALERTS:
STATVT

↓
STATUS,ALERTS:

STATIP
↓

STATUS,ALERTS:
STATC

↓
STATUS,ALERTS:

STATE
↓

STATUS,ALERTS:
STATCEOF

↓
STATUS,ALERTS:

STATTB
↓

STATUS,ALERTS:
STATVDVCC

↓
STATUS,ALERTS: If “CYCLE ALL measurements” is selected, the display 

will cycle through all available status/alert registers.CYCLE ALL
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Status/Alerts Report

The contents of the status/alert registers are reported by 
mnemonics. Due to restricted number of characters, the 
LCD shows acronyms for some of the registers and bit 
names. 

Only the bits that are set (1) are reported. Bits that are 
cleared (0) won’t be reported.

ACRONYM
DATA SHEET 
NAME DESCRIPTION

STAT STATUS The Status Register reports the status of 
Register Updates, Undervoltage Lockout, and 
Reference Clock Errors

UVA UVLOA Undervoltage in the Analog Domain Including 
ADCs During a Conversion

POR PORA Power-On Reset Has Occurred Due to 
Undervoltage in the Analog Domain

UVS UVLOSTBY Undervoltage in the Standby Domain

UVD UVLOD Undervoltage in the Digital Domain

UPD UPDATE Result Registers Have Been Updated 
(Measurement Was Performed)

AER ADCERR The ADC Conversion Is Not Valid Due to 
Undervoltage During a Conversion

TER TBERR Overflow of the Internal Timebase Register. 
The Values of Accumulated Result Registers 
Are Invalid

STATVT STATVT Voltage, Temperature Threshold Alerts 

VH VH Voltage VD High Threshold Exceeded

VL VL Voltage VD Low Threshold Exceeded

TEH TEMPH Temperature High Threshold Exceeded

TEL TEMPL Temperature Low Threshold Exceeded

FH FANH Fan High Temperature Threshold Exceeded

FL FANL Fan Low Temperature Threshold Exceeded

ACRONYM
DATA SHEET 
NAME DESCRIPTION

STATIP STATIP Current, Power Threshold Alerts 

IH IH Current High Threshold Exceeded

IL IL Current Low Threshold Exceeded

PH PH Power High Threshold Exceeded

PL PL Power Low Threshold Exceeded

STATC STATC Charge Thresholds Alerts

C1H C1H Charge 1 High Threshold Exceeded

C1L C1L Charge 1 Low Threshold Exceeded

C2H C2H Charge 2 High Threshold Exceeded

C2L C2L Charge 2 Low Threshold Exceeded

STATE STATE Energy Threshold Alerts 

E1H E1H Energy 1 High Threshold Exceeded

E1L E1L Energy 1 Low Threshold Exceeded

E2H E2H Energy 2 High Threshold Exceeded

E2L E2L Energy 2 Low Threshold Exceeded

STATCEOF STATCEOF Charge, Energy Overflow Alerts 

C1OF C1OF Charge 1 Overflow Alert

C2OF C2OF Charge 2 Overflow Alert

E1OF E1OF Energy 1 Overflow Alert

E2OF E2OF Energy 2 Overflow Alert

STATTB STATTB Time Base Alerts 

1TH TB1TH Time 1 Threshold Exceeded

2TH TB2TH Time 2 Threshold Exceeded

1OF TB1OF Time 1 Overflow

2OF TB2OF Time 2 Overflow

STATVDVCC STATVDVCC VDVCC Threshold Alerts

VDVCCH VDVCCH Voltage at DVCC High Threshold Exceeded

VDVCCL VDVCCL Voltage at DVCC Low Threshold Exceeded
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Serial Terminal Operation
The DC2574A-KIT can also be operated via a serial terminal 
by connecting the Linduino to the USB port of a PC. For 
this you can use the Serial Monitor of the Arduino IDE 
which can be accessed from the Tools menu as shown 
in Figure 2.

Make sure to select the right COM port of your Linduino. In 
the screenshot in Figure 2, COM30 is selected. Depending 
on your system and the used USB port, you may see a 
different COM port number. One way to identify the right 

COM port is to plug and unplug your Linduino and check 
in the list of available COM ports which one disappears.

In the serial monitor, set the baud rate to 115200 and select 
the “No line ending” option, see Figure 3.

Initial output on the serial monitor is:
Hello LTC2947
30A PowerMonitor
LCD found! Enter l or m for options.

Figure 2. Tools Menu

Figure 3. 
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The following table lists the menu items that are shown after entering m or l.

KEY OPTIONS DESCRIPTION

l 0:STATUS
1:STATVT
2:STATIP
3:STATC
4:STATE
5:STATCEOF
6:STATTB
7:STATVDVCC
8:CYCLE ALL
enter 0-8, any other to cancel

Status and Alert Registers Menu. E.g. enter 0 to periodically output the status register via the 
serial monitor and on the LCD.  
Example output:
STAT:UPD,
UVA,POR,UVS,UVD
See Status/Alert Registers (UP, DOWN Keys) for details.

m 0:I V
  P TEMP
1:C1 VDVCC
  E1 TB1
2:C2 VDVCC
  E2 TB2
3:IMIN IMAX
  PMIN PMAX
4:VMIN VMAX
  TMIN TMAX
5:TMIN TMAX
  VDMIN VDMAX
6:CYCLE ALL
  measurements
enter 0-6, any other to cancel

Measurements Menu.  
E.g. enter 0 to periodically output Current (I), Voltage (V), Power (P) and Temperature 
(TEMP) measurements via the serial monitor and on the LCD. 
Example output:
0:I V
  P TEMP
0.012A -0.402V
0.000W 29.2°C
See Measurement Groups (LEFT, RIGHT Keys) for details.

Once one of the options is selected the related results 
will be periodically reported via the serial monitor and 
also via the LCD.

To change the serial output, send again the “m” or “l” 
character and select another option to be displayed or any 
number >8 to disable the serial output.
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QuikEval/GUI OPERATION

The DC2574A-KIT can also be operated via the LTC2947 
GUI which is integrated in the QuikEval evaluation system. 
If not yet installed, QuikEval may be downloaded from the 
linear web page:

http://www.linear.com/quikeval

QuikEval will automatically detect the connected DC2574A-
KIT and download and launch the LTC2947 GUI.

The GUI will automatically connect to the DC2574A-KIT 
on start-up. Please refer to the DC2334 demo manual for 
details on GUI operation.

There are two limitations when operating DC2574A-KIT 
with the GUI:

1.	The LTC2947 will always operate in continuous mode. If 
the continuous mode is disabled via the operation control 

DC2574A-KIT firmware source code

Linduino DC590 Mode

of the GUI it will be enabled again by the DC2574A-KIT 
firmware.

2.	Shutdown is not possible as the DC2574A-KIT firmware 
will wake-up the device again immediately.

3.	If the DC2574A-KIT’s LCD displays any of the status/alert 
registers, asserted bits reported by the LCD might not 
be reported by the GUI and vice versa. This is an result 
of the clear-on-read behavior of those bits when read by 
two agents (the GUI and the DC2574A-KIT firmware). 
This can be avoided by setting the LCD output to any 
of the measurement results, use the LEFT/RIGHT keys 
for this purpose.

4.	Connection to the device is only possible in the GUI’s 
Auto mode or with fixed setting to I2C and slave ad-
dress 0x5C.

Information furnished by Linear Technology Corporation is believed to be accurate and reliable.  
However, no responsibility is assumed for its use. Linear Technology Corporation makes no representa-
tion that the interconnection of its circuits as described herein will not infringe on existing patent rights.

The DC2574A-KIT uses “LTC2947 - DC2574A_KIT Lin-
duino.INO File” available on: 

	 http://www.linear.com/product/LTC2947#code

or in the LTSketchbook (Linduino library) which can be 
downloaded from the Linduino home page:

	 http://www.linear.com/solutions/Linduino

Once installed, the source code may be accessed within 
the Arduino IDE from File → Sketchbook → Part Number 
→ 2000 → 2900 → 2947 → DC2574A_KIT

It is possible to reprogram the Linduino that is part of 
this kit so it can be used for operation with any other LTC 
demo board and QuikEval. This is done by programming 
the DC590 Sketch from the LTSketchbook which is acces-
sible within the Arduino IDE from File → Sketchbook → 
Utilities → DC590B.

After this change, the Linduino can also be used together 
with the DC2334A demo board by connecting the sup-
plied 14-pin ribbon cable to the DC590 connector J4. See 
DC2334A demo manual for more details.

http://www.linear.com/quikeval
http://www.linear.com/product/LTC2947#code
http://www.linear.com/solutions/Linduino
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(408) 432-1900 ● FAX: (408) 434-0507 ● www.linear.com © LINEAR TECHNOLOGY CORPORATION 2016
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DEMONSTRATION BOARD IMPORTANT NOTICE

Linear Technology Corporation (LTC) provides the enclosed product(s) under the following AS IS conditions:

This demonstration board (DEMO BOARD) kit being sold or provided by Linear Technology is intended for use for ENGINEERING DEVELOPMENT 
OR EVALUATION PURPOSES ONLY and is not provided by LTC for commercial use. As such, the DEMO BOARD herein may not be complete 
in terms of required design-, marketing-, and/or manufacturing-related protective considerations, including but not limited to product safety 
measures typically found in finished commercial goods. As a prototype, this product does not fall within the scope of the European Union 
directive on electromagnetic compatibility and therefore may or may not meet the technical requirements of the directive, or other regulations.

If this evaluation kit does not meet the specifications recited in the DEMO BOARD manual the kit may be returned within 30 days from the date 
of delivery for a full refund. THE FOREGOING WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY THE SELLER TO BUYER AND IS IN LIEU 
OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR ANY PARTICULAR PURPOSE. EXCEPT TO THE EXTENT OF THIS INDEMNITY, NEITHER PARTY SHALL BE LIABLE TO THE OTHER FOR 
ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user releases LTC from all claims 
arising from the handling or use of the goods. Due to the open construction of the product, it is the user’s responsibility to take any and all 
appropriate precautions with regard to electrostatic discharge. Also be aware that the products herein may not be regulatory compliant or 
agency certified (FCC, UL, CE, etc.).

No License is granted under any patent right or other intellectual property whatsoever. LTC assumes no liability for applications assistance, 
customer product design, software performance, or infringement of patents or any other intellectual property rights of any kind.

LTC currently services a variety of customers for products around the world, and therefore this transaction is not exclusive.

Please read the DEMO BOARD manual prior to handling the product. Persons handling this product must have electronics training and 
observe good laboratory practice standards. Common sense is encouraged.

This notice contains important safety information about temperatures and voltages. For further safety concerns, please contact a LTC application 
engineer.

Mailing Address:

Linear Technology

1630 McCarthy Blvd.

Milpitas, CA 95035

Copyright © 2004, Linear Technology Corporation
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